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These release notes highlight new functionality, enhancements, software and hardware dependencies, and 

include upgrade instructions for the NetVanta Unified Communications product family.  This document is to be 

used in conjunction with product documentation and training for the preparation of new and existing software 

installations and is intended for technical professionals who are providing support services for NetVanta Unified 

Communications products. 

For general product information, please visit ADTRAN’s website at http://www.adtran.com. 

CAUTION:  It is strongly recommended that the contents of this document be reviewed before any 
installation or upgrade, no matter how familiar the installer is with the product, to ensure that 
current installation and upgrade procedures are followed. These procedures could change from 
release to release, including maintenance releases. Failure to follow the upgrade procedures in this 
document could result in non-operational systems. 

1 Summary of Changes 

This section summarizes new functionality introduced in this NetVanta UC Server release, along with issues 

resolved in each release and any release-specific actions that are required as part of upgrading. Each maintenance 

release is identified separately. More detailed descriptions for major new functionality follow in Section 2 New 

Functionality Details,. Internal tracking numbers are noted (for example, [1234]). 

For newly introduced functionality and issues resolved in previous major releases, please consult the release notes 

or product documentation for the respective releases.  

Where functionality or issues resolved do not apply to products in the product family, the applicable products are 

noted (for example, ECS, BAS, UCS). 

NOTE:  Be sure to review all upgrade actions for all releases between your current release and the release and 

your upgrade. Subsections of the sections below identify required actions, including information about client 

upgrades.  

1.1 Release 5.1.0 
 

Release 5.1.0 is a release update of NetVanta UC Server version 5.0.x which extends existing functionality 

including UC Presence and IM Federation and leverages greatly its interoperation with third-party products 

including official support of VMware™ virtual environments. This release officially supports integrations with 

distributed Exchange 2010 Servers, adds support for the Polycom VVX-500 series phone type and also provides 

user selectable language (French audio-only) support.  Additional interoperation with ADTRAN products namely 

the NetVanta 7100, the TA9xx series and SBC Feature Packs are now also supported. ECS, BAS, UCS     

 

This release also simplifies UC product licensing to minimize migration strategies from UCS to ECS in order to 

provide an easier deployment of product feature attributes. ECS, BAS, UCS     

  

http://www.adtran.com/
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2 New Functionality Details 
 

This section describes the new functionality introduced in this NetVanta UC Server release.  Where functionality 

or issues resolved do not apply to products in the product family, the applicable products are noted. 

2.1 Release 5.1.x 
 

NetVanta UC Server Release 5.1.0 is a minor release which incorporates all existing features and functionality of 

past NetVanta UC Server releases combined with the introduction of the following features:  

 

Presence and IM Federation  

This enhanced feature provides centralized ADTRAN UC presence on the desktop of multiple UC systems 

configured on the network. This newly federated “ucCompanion” desktop client provides all previously existing 

UC client functionality and adds shared presence user information of multiple UC Servers configured on the 

following Communications Systems: 

a. Enterprise Communications Server (embedded SIP PBX) ECS 

b. Business Communications System (7100/7060)   BCS 

c. Unified Communications System (IM support only)   UCS 

The Federated features are now extended to the following: 

 

 Calling from the desktop, IM (Instant Message), Status Notes  and configuration settings  

 Search and Groups management 

 Icons to show status (different colors) 

 Status: Available, Not Available, Busy, Away, Do Not Disturb, Out of Office  

 General Business Instant Messaging   

 

Formal VMware Support 

This enhancement formally certifies UC product families with VMWare™ as a VMWare Ready product.  This is 

part of VMWare Technology Program as specified by the requirements listed below:   

1. Qualification and submission of a workload test against a virtual configuration 

2. Customer references of deployed application in VMWare environment 

3. Product submission/description for VMWare Product Catalog 
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Simplified UC ECS Licensing 
 
This enhancement collapses the 2 sets of port/application license attributes into a single feature attribute while 

maintaining the current licensing requirements of existing customers. The current licensing strategy has been 

altered to allow for a more simplified and efficient migration of UCS customers over to ECS where required. 

 

911-Enable Phone information export 

The UC Server system now includes a PowerShell snap-in which provides various attributes required to retrieve 

user identities and phone information from UC Servers.  This exported data will allow support of Enhanced 911 

services from third party providers such as 911-Enable as it relates to CPE appliances. 

 

Dialogic Media Gateway single voicemail and extension calling support 

As part of a UCS/ECS blend-and-extend strategy of mixed UC and traditional PBX legacy installations (e.g. 

Nortel), a validation exercise was performed to qualify a single DMG in the performance of both operational call 

types: UCS server as voicemail and extension to extension calling between the PBX users and ECS users.  

 

French Language TUI – Audio support 

Continued enhancements to the French Language TUI now include localized storage of French audio prompts 

including proper language context and syntax. A user selectable interface menu is now located in the 

Administrative Options of the UC product to allow for a simplified audio language selection.   

 

Polycom phone VVX-500 series support 

The new Polycom VVX-500 series phone is now supported in this latest release including the provisioning 

firmware along with its menu inclusion in the UC Server’s Phones management section. ECS only  

 

Exchange 2010 Distributed support 

Exchange 2010 Server support has been extended for CAS and HUB Transport server configurations where 

multiple mailbox databases exist or where the CAS or HUB Exchange Servers are separated from the Exchange 

Mailbox Database(s) within a Microsoft AD (Active Directory) Domain.  
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Software fixes included in release 5.1.x since 4.6.4  

 

Tracking # Summary 

UCS-357 Start application at login setting implies login  

UCS-610 Phone behind stateful proxy fail to register BLF's 

UCS-287 Multiple windows created for same conversation 

UCS-356 Park call failing where call  initiated by phone when Proxy grammar commands in use 

UCS-348 Call to user PBA service is routed outbound but failing with prompt 481 

UCS-351 Unable to "forget" saved password for a user that has logged in successfully and saved their 

password 

UCS-352 Sign In button remains unexpectedly 'active' when in some login scenarios 

UCS-371 Removing from one group can remove unexpectedly from another group 

UCS-378 Renaming the Communication System via Admin client does not get reflected in the ucCompanion 

extension list 

UCS-379 Auto-login to ucCompanion using saved password fails when application server is restarted 

UCS-380 Modifying Polycom phone configuration of BLF's triggered crash/restart (subscriptions not 

accepted) 

UCS-382 Polycom 430 has only 2 buttons but the Phone dialog allows 3 lines/3 buttons 

UCS-385 AddUser.exe crashes when executed from cmd line 

UCS-407 ucCompanion setting to "Ignore identical consecutive clipboard strings" unexpectedly becoming 

re-enabled after Exiting ucCompanion 

UCS-428 User Pin value ignored on import of users from file 

UCS-433 Using LA with blind transfers,  the softphone does not handle Notifies properly 

UCS-446 SIM stack overflow during call management on the LA console 

UCS-448 Transfer fails where original Invite uses TCP protocol 

UCS-476 Importing users from file where file contains TelephoneMacAddress and TelephoneType fails to 

add the phone  

UCS-495 Calls  during park failover, does not receive ringback or  failover to voicemail or service  

UCS-500 Admin client hangs sorting Users pane  

UCS-504 Server restart may be triggered during  BLF subscriptions 

UCS-509 ucCompanion search by last name only returns users and not identities where the last name 

matches  
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Tracking # Summary 

UCS-519 When focus returns to service editor  UC Client error dialog may cause "Unspecified error" 

UCS-534 Null error launching UC Management shell when server login info is not saved to registry. 

UCS-540 Port leakage on faxing 

UCS-549 Error dialog appearing when selecting  the "Gateways" radio button in dial plan 

UCS-567 "Contact database" for Local message store users client-side contact matching may fail 

UCS-584  BCS 7100 callers unexpectedly treated as "Unknown caller" even though identity exists 

UCS-402 Creating or listing a large number of users where many phones are already configured  slow to load 

UCS-299 ucCompanion "Dialing notification" setting cannot be enabled  

UCS-73 Contact rules matching on Exchange 2010 no longer working properly 

UCS-254 Multiple conversations windows can be opened with same recipient after participant exits  

UCS-81 Selected or multi-selected items in ucCompanion do not appear in highlighted state when right 

click 

UCS-178 In the ucCompanion Conversation dialog, the "Save" and "Options" settings buttons do not 

highlight on mouse over 

UCS-193 Minimum digits requirement met in search criteria but search from ucCompanion did not return 

the value as a phone number 

UCS-195 ucCompanion settings dialog "Save" button not enabled after making a change to a numeric value  

UCS-241 Sorting order not refreshed when user information is changed 

UCS-261 ucCompanion Conversation window position and size is not retained in next Conversation 

UCS-275 Some ucCompanion Settings not working as expected when "Defaults"  is selected 

UCS-283 Notification Options settings in ucCompanion not retained when deselecting  "Show notification 

when new message arrives" 

Note that all fixes from previous 4.x releases up to and including 4.6.x will also be included in release 5.1. Please 

consult the specific 4.x /4.6.x/5.0.x release notes for details on issues resolved in those releases. 

2.1.1 Upgrade Requirements 

Prior to upgrading an existing NetVanta UC Server system, be sure that the hardware platform and operating 

system software meet the minimum requirements; otherwise, you will not be able to upgrade the software. 

Ensure that both client and server requirements are met. Refer to Section System Requirement 3.2 for 

information. 

CAUTION:  Failure to preserve installed software release media properly could result in the inability 
to rebuild a failed server at a later date. Copies of noncurrent software versions might not be readily 
available from ADTRAN Technical Support or your reseller causing delays to support technicians 
rebuilding failed servers. 
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2.1.2  Client Upgrade Actions 

Client software MUST be upgraded for all users of the NetVanta UC Server system. More information on client 

deployment techniques, including automated deployment can be found in Section 4.3, Installing or Upgrading 

NetVanta UC Client Software. 

2.1.3 Other Upgrade Actions 

If the administrator has customized any of the system audio files (Data\System\Announcements) and not 

placed them in the custom announcements folder (Data\System\CustomAnnouncements), then the 

customized files MUST be copied to the overrides folder.  

CAUTION:  Failure to copy or backup customized audio files will cause them to be overwritten 
during the upgrade. 

For upgrades of the ECS and BAS products, scripts MUST be run before and after upgrading to properly upgrade 

phone configuration files. Any customizations to phone configuration files must be manually re-applied using the 

information and backups made by the scripts. Refer to Section 4.2.2, Upgrading NetVanta UC Server from any 4.x.x 

Release, for more information on this procedure. 

CAUTION:   The SQL database instance for NetVanta UC Server MUST be backed up to ensure 
proper recovery of failed systems. For instructions on backup and restore procedures, refer to the 
Planning and Deployment Guide, available online at https://supportforums.adtran.com. Please 
adjust backup procedures accordingly. Failure to do so could result in data loss or extended system 
outages in the case of hardware or software failures. 

Please note that any upgrade from 4.x to 5..x UC releases will convert the existing SQL 2005 
database instance named Objectworld to an SQL 2oo8 instance named NetVantaUC.  You will 
need to adjust any existing backup script to support this instance name change already put in place 
as part of  a scheduled backup maintenance routine . 

  

https://supportforums.adtran.com/
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3 Installation Requirements 

This section describes the environmental prerequisites required for the correct operation of NetVanta UC Server, 

including operating systems, server/client platforms, messaging servers, and mail clients. In addition, it describes 

any steps required prior to installing NetVanta UC Server software, including obtaining the license key. 

3.1 Preserving Installation and Upgrade Media 

If physical installation media (a CD or DVD) was received, please store this media in a safe place so that the 

software can be reinstalled at a later date if necessary (for example, in the event of a hardware failure). 

If the software was downloaded, please ensure  that a separate copy of the installation media is made to CD or 

DVD and this media is stored in a safe place so that the software can be reinstalled at a later date if necessary (for 

example, in the event of a hardware failure). Do not store the downloaded media on the same physical disks as 

the operational server as a single disk failure could cause this media to be permanently lost. 

Ensure that if software upgrades are performed, new versions are also stored on separate media in a safe place. 

Support personal could require a copy of the installation media to reinstall software at a later date. 

CAUTION:  Failure to preserve installed software release media properly could result in the inability 
to rebuild a failed server at a later date. Copies of noncurrent software versions might not be readily 
available from ADTRAN Technical Support or your reseller causing delays to support technicians 
rebuilding failed servers. 

3.2 System Requirements 

3.2.1 Server Components 

This section describes the required operating systems, hardware requirements, and third-party integration 

platforms for the NetVanta UC Server server components. This applies to both upgrades and new installations. If 

existing server hardware does not meet these requirements, it must be upgraded or migrated to new hardware 

prior to upgrading to this release of NetVanta UC Server. 

3.2.1.1 Operating Systems 

The NetVanta UC Server server components support the following Operating Systems: 

Microsoft® Windows™ 

 Microsoft Windows Server 2008 R2 (x64) 

o Foundation, Standard, Enterprise, and Data Center editions are supported. 

o Deployment on Server Core or Hyper-V is not supported. 

 

 Microsoft Windows Small Business Server 2008 (x64) 

The recommended deployment for optimal performance and reliability is to install NetVanta UC 
Server on the additional Windows Server 2008 license that is part of the Premium Edition of 
Windows Small Business Server 2008. NetVanta UC Server can also be installed on the Windows 
Small Business Server 2008 platform with suitable hardware. Refer to Section 3.2.1.3, Hardware 
Requirements, for more information. 

 Microsoft Windows Server 2008 (x86, x64) 

o Foundation, Standard, Enterprise, and Data Center editions are supported. 

o Deployment on Server Core or Hyper-V is not supported. 



NetVanta Unified Communications 

 
11 

 Microsoft Windows Server 2003 R2 SP1, SP2 (x86) 

 Microsoft Windows Server 2003 SP1, SP2 (x86) 

 Microsoft Windows Small Business Server 2003 SP1 (x86) 

VMware vSphere™ 

 VMware vSphere 4.1 

 VMware vSphere 5.0 

3.2.1.2 Deprecated Operating Systems (no longer supported as of 5.0.x) 

 Microsoft Windows XP SP2, SP3 (Professional) (x86) 

 Microsoft Windows Essential Business Server 2008 (x86, x64) 

 Microsoft Windows Small Business Server 2011 (x86, x64) 

 

 

Other software platforms are not supported. 

Installation of the server components into other virtualization environments (Virtual Server, Hyper-V, Virtual PC, 

Virtual Box, etc.) is not supported in production deployments.  Due to the real-time nature of 

telecommunications, audio problems may be experienced in these environments. ADTRAN recommends using 

server operating system only for all installations of NetVanta UC Server.  

CAUTION:  When using TAPI integrations, or other integrations requiring use of CTI drivers, please 
review driver documentation for those products BEFORE proceeding with plans to use Windows 
Server 2008 or Windows Server 2008  derived platforms (SBS 2008/2010) as the server platform for 
those deployments. 

3.2.1.3 Hardware Requirements 

To install NetVanta UC Server, the server hardware platform must meet the minimum requirements in the 

following table. The minimum requirements are for a minimal installation. The recommended requirements are a 

guideline for more robust, reliable, and future-proofed systems.  

Product engineering guidelines and recommendations should be consulted and followed for anything other than a 

minimal installation (for example, installations with more than 25 users). Sizing of the server hardware is 

dependent on the number of users, the traffic levels, and application services used. Selection of hardware should 

also take into account such things as redundant power supplies, uninterruptable power supplies (UPSs), and 

redundant disk arrays (for example, RAID) so that the end users’ needs and expectations are met, along with any 

future growth requirements.  

Consult TN102 - Hardware Platform Recommendations and the Planning and Deployment Guide, available online at 

https://supportforums.adtran.com, for more information on correctly selecting the hardware. 

Hardware 

Component 

Minimum Recommended 

Processor Intel Pentium Dual-Core (E2140) Intel Xeon Quad-Core (E5310) 

RAM 4 GB 

4 GB on Windows Small Business Server 2003 

6 GB on Windows Small Business Server 2008 

4 GB 

6 GB on Windows Small Business Server 2008 

https://supportforums.adtran.com/
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Hardware 

Component 

Minimum Recommended 

Disk space 80 GB (usable space) 

7200 RPM 

146 GB (usable space) 

SAS – RAID 1 or RAID 5 

3.2.2 Mail/Messaging Servers for Unified Messaging 

NetVanta UC Server supports the following email servers for Unified Messaging: 

 Microsoft Exchange™ Server 2000, 2003 SP1 (requires service pack 1 or later), 2007**, 2010, SP1/Sp2 ** 

WARNING:   ** Changes in the Exchange Mailbox detection logic  for connecting to Microsoft 
Exchange Server 2010 or 2007 when the Exchange Mailbox, Client Access, and Hub Transport do not 
reside on the same server may require disconnecting and re-connecting the mailbox to ensure 
proper connectivity to the server in this configuration after an upgrade.  

 IBM® Domino™ Server 6.0.x, 6.5.x, 7.0, 8.0 (via IMAP) 

 Google Mail (via IMAP using stunnel) 

 University of Washington IMAPd 

 Any 100 percent compliant IMAP4rev1 (RFC 3501) message store (different servers could require different 

query optimization techniques – consult product documentation for query optimization technique 

determination procedures) 

Integration with Microsoft Exchange Server requires a MAPI connector to be installed on the NetVanta UC Server 

platform. The supported MAPI connectors, of which only one should be installed on the server platform, are the 

following: 

 Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1  

(Version: equal or greater than 6.5.8165.0, 2010-Apr-28 – older versions are not compatible with all 

platforms).This is available for download free of charge from: 

http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-

0a110307611e&displaylang=en 

 

 Microsoft Outlook™ 2003 SP3 only 

CAUTION:  Microsoft Outlook 2003 as a MAPI connector is not supported and will cause unreliable 
integration with Microsoft Exchange Server 2010 and could cause system outages. 

 Microsoft Outlook 2007 SP1 only  

CAUTION:  Outlook 2007 SP2 is not compatible as a server MAPI connector with UC Server and 
installing it will cause NetVanta UC Server to be unable to connect to Exchange Server. 

 All Microsoft Exchange 2010 integrations are only supported with MAPI Client and Collaboration 

Data Objects 1.2.1 

CAUTION:  Outlook 2010 is not compatible as a server MAPI connector with UC Server and 
installing it will cause NetVanta UC Server to be unable to connect to Exchange Server. 

http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-0a110307611e&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-0a110307611e&displaylang=en
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ADTRAN recommends using Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 instead 

of Microsoft Outlook and strongly encourages all customers to switch to this MAPI connector instead of Outlook. 

The benefits of doing this are as follows: 

 No Outlook license is required for the NetVanta UC Server system. The MAPI/CDO package is available 

at no charge. 

 The MAPI/CDO package is a minimal installation that requires fewer Microsoft Updates. 

 This component is designed and provided by Microsoft explicitly for the purpose of allowing applications 

such as NetVanta UC Server to access Exchange Server and does not include many of the client-side 

nuances of Outlook versions of MAPI. 

On Exchange Server 2003, additional steps are required after following the manual integration instructions in 

Appendix A of the Configuration Guide: 

Delegate Exchange View-Only Administrators control to the NetVanta UC Server service account: 

1. Open Exchange System Manager on an Exchange Server in the enterprise, or an administrative workstation. 

2. Select the enterprise level object (the root object in the tree). 

3. Select Delegate control… from the Action menu. This will open the Exchange Administration Delegation 

Wizard. 

4. Click Next. 

5. In the Users or Groups page of the wizard, click Add to open the Delegate Control dialog box. 

6. Select the role Exchange View Only Administrators from the list of roles. 

7. Click Browse… and select the service account used by NetVanta UC Server for Exchange Server and network 

integration. 

8. Click OK in the Select Users, Computers or Groups dialog box. 

9. Click OK in the Delegate Control dialog box. 

10. Click Next in the Users or Groups page of the Exchange Administration Delegation Wizard. 

11. Click Finish to complete and close the wizard. 

3.2.3 Client Components 

This section describes the required operating systems and hardware requirements for the NetVanta UC Server 

client components. Most installations will deploy client software to some or all of the end users of the system. 

Some installations do not require deployment of the client software depending on how NetVanta UC Server will 

be used. 

3.2.3.1 Operating Systems 

The NetVanta UC Server client components (NetVanta UC Client, NetVanta ucCompanion, and NetVanta 

ucCompanion - Live Attendant) support the following Microsoft® Windows™ Operating Systems: 

 Microsoft Windows 7 (Professional, Ultimate, or Enterprise Editions) (x86, x64) 

 Microsoft Windows Vista, SP1, SP2 (Business, Ultimate, or Enterprise Editions) (x86, x64) 

 Microsoft Windows XP SP2, SP3 (Professional or Tablet PC Editions) (x86) 

 Microsoft Windows Server 2008 R2 (x64) 

 Microsoft Windows Server 2008 (x86, x64) 

 Microsoft Windows Server 2003 R2, SP2 (x86) 

 Microsoft Windows Server 2003 SP1, SP2 (x86) 

Other software platforms are not supported. 
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3.2.3.2 Prerequisite Components 

Client components now requires a minimum version of Microsoft .NET Framework 4.0 to be installed on target 

systems. In addition, for some components additional Microsoft redistributable components will be installed by 

the client installer. 

3.2.3.3 Hardware Requirements 

To install NetVanta UC client, the platform must meet the following minimum requirements for the specified 

Microsoft Windows operating systems listed below.  

Client XP, Server 2003 Vista, Windows 7, Server 2008, 

Server 2008 R2 

Processor x86 compatible processor 

600 MHz or higher 

x86 or x64 compatible processor 

1 GHz 

RAM 1 GB 1 GB 

Free Disk space 500 MB 500 MB 

Video Super VGA (800 x 600) or higher 

resolution video adapter and monitor 

Support for DirectX 9 graphics with: 

 WDDM Driver 

 Minimum 128 MB graphics 

memory  

 Pixel Shader 2.0 in hardware 

 32 bits per pixel 

3.2.3.4 Email Clients for Unified Messaging 

NetVanta UC Client integrates with the following email clients for Unified Messaging: 

 Microsoft Outlook  2002/XP, 2003 SP3, 2007 and 2010 (x86) 

 Microsoft Outlook 2010 64 bit without UC voice/fax form client support 

 IBM Lotus Notes™ 6.0x, 6.5.x, 7.0, 8.0 

3.3 Product Licensing (License Key) 

All NetVanta UC Server products must be correctly licensed to operate. The license key obtained from ADTRAN is 

specific to each installation and defines the exact functionality licensed by the end user for their installation. 

3.3.1 New Installs 

When installing NetVanta UC Server for the first time, you must obtain a license key to install and activate the 

software. 

3.3.2 Upgrades 

To upgrade NetVanta UC Server from a previous major or minor release, you must obtain a new license key prior 

to beginning the upgrade.  The existing license key, found in the License Information dialog box in the 

administrative NetVanta UC Client must be updated to the new license key prior to beginning the upgrade.  After 

the new key is installed, you can continue to upgrade the server software. You do not need a new license key for 

maintenance (patch or dot) releases. 

Upgrade license keys are only available to customers who have an active Software Assurance subscription. 

http://www.microsoft.com/en-us/download/details.aspx?id=17851
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3.3.3 Obtaining a New License Key 

To obtain a new or upgrade a license key, fill out a license key request in the UC Tools area of the ADTRAN 

website (http://www.adtran.com/uctools).  

Note: Please allow enough time to obtain the license key – at least one (1) business day should be allocated to 

ensure the license key is obtained before installation or upgrade.  

You will need the following information: 

1. Contact information 

2. Product Keys  

 New installs: available from materials that shipped with the product. 

 Upgrades: available for a user with Administrator privileges. From NetVanta UC Client, select the Help 

menu > License Information. 

3. Purchase key 

 New installs: available from materials that shipped with the product. 

 Upgrades are available:  

 For a user with Administration privileges: From within NetVanta UC Client, select the Help > License 

Information. Click Modify license. 

 From the Product Licensing Wizard dialog box from Step 1 of NetVanta UC Server Configuration 

Wizard. 

4. Machine ID  

 New installs: available from the Product Licensing Wizard dialog box of Step 1 of the NetVanta UC Server 

Configuration Wizard. 

 Upgrades are available:  

 For a user with Administration privileges: From NetVanta UC Client, select the Help > License 

Information. Click Modify license. 

 From the Product Licensing Wizard dialog box of Step 1 of NetVanta UC Server Configuration 

Wizard. 

5. Platform specifications (CPU speed, RAM, and server OS) – available from the System control panel in the 

Windows Control Panel. 

6. Product version and edition you will be installing or upgrading – available from the materials shipped with the 

product. 

7. Message store type (Microsoft Exchange Server, Lotus Domino/Notes, IMAP4, or local machine) and version. 

8. Legacy PBX interconnection, if applicable: PBX type, firmware version. 

3.4 Prerequisite Components 

NetVanta UC Server requires that prerequisite components be installed prior to installing the NetVanta UC Server 

software. The installer will detect which components are missing from the system and prompt accordingly.  Some 

of the prerequisite components are included on the distribution media and can be installed automatically by the 

installer. However, others must be obtained directly from the vendor. Links to the relevant web-sites for any 

components that require downloading will be provided by the installer. 

Not all prerequisites are required on all operating systems; specifics are noted below. Except where indicated, the 

prerequisites are installed automatically by the installer. The prerequisite components are: 

 Microsoft .NET Framework 3.5 SP1 (download link provided in installer) 

 Windows Server 2008 Enhanced Desktop Feature (a reboot is required after installation) [Windows 

Server 2008-based systems only pre-requisite Microsoft Windows Server 2008 Roles and Features] 

http://www.adtran.com/uctools
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 *Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (Version: 6.5.8165.0, 

2010-Apr-28 - older versions are not compatible with all platforms 

 Microsoft Visual C++ 2005 SP1 Redistributable Package (x86/x64) 

 Microsoft Visual C++ 2008 SP1 Redistributable Package (x86/x64) 

 Microsoft SQL Server 2008 Express Edition 

 ADTRAN Software Diagnostic Logging Tools 
 
*MAPI Client and Collaboration Data Objects pre-requisite used for integration with Exchange. 

CAUTION:  NetVanta UC Server will only work correctly with the version of Microsoft SQL Server 
that is provided on the distribution media. Other instances of SQL Server cannot be used by 
NetVanta UC Server. 
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4 Installation and Upgrade Instructions 

Please review Section 3 Installation Requirements before proceeding with this section. It contains important 
information about product licensing, system requirements, and the versions of required external software 
components.  

CAUTION:  Failure to comply with the installation requirements, or properly follow the installation 
or upgrade instructions will result in an inoperable or poorly performing system. 

4.1 New Install of NetVanta UC Server 

This section contains an overview of the installation for NetVanta UC Server; for detailed installation procedures 

consult the Installation Guide applicable to your NetVanta Unified Communications product. To facilitate 

installation and configuration, have the following reference material available during installation: 

 Release Notes (this document) 

 Planning and Deployment Guide 

 Installation Guide 

 NetVanta Unified Communications Server Presence and Control Components Guide (for use with NetVanta 

ucCompanion - Live Attendant) 

 Configuration Guide 

 Administrator Manual 

 NetVanta ucCompanion Desktop Presence User Guide 

To ensure that all the required information is available during the installation and configuration process, it is 

recommended that the Planning and Deployment Guide Worksheet be completed. 

4.1.1 Installing the Server Software 

The installation software will automatically verify the prerequisites for software installation.  Make sure that you 

run the installation from a Windows logon that has the ability to install software on the NetVanta UC Server 

system (for example, Administrator privileges). 

To install NetVanta UC Server: 

1. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on NetVanta UC Server (you 

will need to provide a location and name for the folder).  Start the installation by double clicking on 

CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). 

b. Insert the NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN 

NetVanta Unified Communications CD menu will appear. 

Install the applications to the NetVanta UC Server platform by clicking on the Install Server button on the 

installation screen and following the prompts on the subsequent screens. 

a. Ensure that all prerequisites are installed. These will vary depending upon your platform and the 

components purchased, such as the Presence and Control components and the Windows 2003 

Server Administration Tool Pack. The NetVanta UC Server Installation Wizard will ensure that all 

prerequisite components are installed before proceeding. 

b. After all the prerequisite components are successfully installed, the wizard allows you to install the 

NetVanta UC Server software. 

2. Run the NetVanta UC Server Configuration Wizard, Configure UC Server.  The NetVanta UC Server 

Configuration Wizard allows you to specify server properties such as message store, NetVanta UC Server 
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administrator password, PBX information, and dialing properties.  The wizard guides you through the server 

configuration process. The wizard does most of the configuration tasks automatically, however, site specific 

information about the network and server needs to be entered at various steps. 

3. When installing NetVanta UC Server for the first time, you must obtain a license key. To obtain a license key, 

please refer to Section 3.3, Product Licensing (License Key). 

4.1.2 Installing the Client Software 

In order for NetVanta UC Server users to take full advantage of its functionality, client software should be 

deployed to their desktop or laptop computers. Refer to Section 4.3, Installing or Upgrading NetVanta UC Client 

Software, for installation options and procedures. 
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4.2 Upgrading/Cross-grading NetVanta UC Server 

CAUTION:  Backup procedures have changed from previous releases. For instructions on backup 
and restore procedures, refer to the Planning and Delpoyment Guide, available online at 
https://supportforums.adtran.com, and adjust backup procedures accordingly. Failure to do so could 
result in data loss or extended system outages in the case of hardware or software failures. 

4.2.1 Upgrade/Cross-grade Matrix 

The following table describes which versions of NetVanta UC Server can be upgraded to newer versions and which 

versions of CallAttendant Office can be cross-graded to NetVanta UC Server. 

To 

 

From 

4.0.x
 

(UC Server) 

4.6.x 

(NetVanta UC 

Server) 

5.0.x 

(NetVanta UC 

Server) 

5.1.x 

(NetVanta UC 

Server) 

Pre 3.2.x  

(CallAttendant Office) 

Unsupported via 
direct upgrade – 
upgrade to 3.2.x 

first, then to 4.0.x 

Unsupported via 
direct upgrade – 
upgrade to 3.2.x 

first, then to 4.0.x 

Unsupported via 
direct upgrade – 
upgrade to 3.2.x 

first, then to 4.0.x 

Unsupported via 
direct upgrade – 
upgrade to 3.2.x 

first, then to 4.0.x 

Post 3.2.x   

(CallAttendant Office) √ 

Unsupported via 
direct upgrade – 
upgrade to 4.0.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.0.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.0.x 

first 

4.0.x  

(CallAttendant Office) √ √ 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

4.2.x  

(CallAttendant Office)  √ 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

4.0.x  

(UC Server)  √ 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

4.1.x  

(UC Server)  √ 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

4.2.x  

(UC Server)  √ 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

4.3.x 

(UC Server) 
 √ 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

https://supportforums.adtran.com/


NetVanta Unified Communications 

 
20 

first first 

4.4.x  

(UC Server)  √ 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

Unsupported via 
direct upgrade – 
upgrade to 4.5.x 

first 

4.5.x 

(NetVanta UC Server)  √ √ 

Unsupported via 
direct upgrade – 
upgrade to 4.6.x 

first 

4.6.x  

(NetVanta UC Server) 
 √ √ √ 

5.0.x  

(NetVanta UC Server) 
 √ √ √ 

5.1.x  

(NetVanta UC Server) 
 √ √ √ 

 

In order to upgrade from older versions, interim upgrade steps must be followed. Refer to the applicable section 

below for more details. 

4.2.2 Upgrading NetVanta UC Server from any 4.x.x Release 

CAUTION:  The existing version of NetVanta UC Server must NOT be uninstalled prior to 
upgrading. The installation process requires that the existing implementation be available in order 
to perform the upgrade correctly. 

The following is a summary of the upgrade procedure from any NetVanta UC Server 4.x.x release; refer to the 

Installation Guide applicable to your NetVanta Unified Communications product, available online at 

https://supportforums.adtran.com, for detailed instructions on installing this component.  

CAUTION:  Failure to follow the steps below, exactly as described, could result in a system that does 
not upgrade or operate correctly after upgrade. 

Perform the following steps: 

1. If performing a major or minor upgrade, obtain a new license key. Please refer to the instructions in Section 

3.3, Product Licensing (License Key). 

2. Backup the NetVanta UC Server. For instructions on backup and restore procedures, refer to the Planning and 

Deployment Guide applicable to your NetVanta Unified Communications product, available online at 

https://supportforums.adtran.com. Backing up will preserve the following data: 

a. Users (greetings, services, announcements) 

b. Port configuration 

c. Attendant data 

d. System configuration 

e. Routing data 

f. Telephone data 

g. Gateway data 

https://supportforums.adtran.com/
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h. PBX configuration data 

CAUTION:  Failure to backup the data according to these instructions and the Technical Note will 
result in the inability to restore the system to the original configuration should the upgrade process 
be unsuccessful or aborted. Always back the system up prior to upgrading. 

3. If a new license key was obtained in Step 1, modify the current license key using the following procedure: 

a. Open NetVanta UC Client using the current installed product version and log in as a user with 

administrative privileges. 

b. Select License Information… under the Help Menu on the main toolbar. 

c. Click the Modify license… button to open the Modify License dialog box. 

d. Enter the new license key in the space provided. 

e. Click OK to close the Modify License Dialog box. 

f. Click Close to close the License Information Dialog box. 

g. Close NetVanta UC Client by clicking the top right corner x icon or selecting Close from the File menu. 

4. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will 

need to provide a location and name for the folder). 

b.  Insert the NetVanta UC Server CD-ROM. The CAAutoRun application will start, and the ADTRAN 

NetVanta Unified Communications CD menu will appear – leave this open for now, you will use it later. 

 

5. For ECS and BAS product variants, run the Pre-Update.bat script file as follows: 

IMPORTANT  NOTICE:   For upgrades of  ADTRAN phone family types, custom configurations 
will be lost unless the following changes are made prior to running the Pre-Update.bat 

a. Locate the ADTRAN.original.zip on the release media 

“Release\Utility\Scripts\ADTRAN.original.zip” or via http://www.adtran.com/support/ 

b. Extract the zip to the following location:  "C:\Program Files\ADTRAN\NetVanta UC 
Server\Data\System\PhoneTypes\ADTRAN 

c. Run the Pre-update and Post-updates as instructed  

 

a. Click the Start menu and select Run… 

b. Type cmd.exe and click OK to open a command prompt window 

NOTE: On systems with User Account Control (UAC) enabled, such as Windows Server 2008 R2, you 

must start the command prompt window as Administrator. To do this, instead of Step a and Step b 

above, do the following: 

1. Click on the Start menu. 

2. Type cmd.exe in the search bar. (If classic start menu is enabled, locate Command Prompt under 

All Programs | Accessories instead.) 

3. Right click on cmd.exe in search results (or Command Prompt in the menu), and select Run as 

administrator. 

4. Accept the UAC prompt to elevate the command prompt to administrative privileges. 

 

c. Navigate to the script folder on the installation media using the CD command. This is located in the 

Utility\Scripts subfolder of the installation media. 

Example: CD /d C:\NetVantaUCServerInstallMedia\Utility\Scripts 

http://www.adtran.com/support/
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d. Run the Pre-Update.bat script, supplying any appropriate parameters relevant to your installation: 

Syntax: Pre-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder] 

 If your NetVanta UC Server installation is not located at C:\Program 

Files\ADTRAN\NetVanta UC Server\, you must specify the location of the PhoneTypes 

system data folder as shown in the example below. 

 If backups should be written to a location other than C:\Backup\PhoneTypes, then you 

must specify a backup folder as shown in the example below. 

 The /? option provides help on the script; the /V option provides more detailed output and 

logging. 

Example: Pre-Update.bat "C:\Program Files\ADTRAN\NetVanta UC 
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\" 

e. When the script prompts you to continue, confirm the information displayed, type Y, and then press 

Enter. 

f. Examine the output of the script to ensure it ran correctly. The output is placed in a file called 

Pre-Log.txt in the backup location. The default backup location is C:\Backup\PhoneTypes. 

g. Leave the command window open because it will be used later. 

6. The ADTRAN NetVanta UC Server Application Services service could be unable to be started during the 

upgrade due expiry of the service account password. This can also occur spontaneously on some Windows XP 

installations or in networks where account passwords have to be changed regularly, but will not be detected 

until the machine is restarted or the ADTRAN NetVanta UC Server Application Services service is restarted. 

Be sure to have the service account password accessible in order to reset it immediately. 

To verify that the service account password has not expired, do the following: 

a. Open the Services administration tool from Start > Control Panel > Administrative Tools. 

b. Locate the service named ADTRAN NetVanta UC Server Application Services. 

c. Right click on the service, and select Restart from the context menu. 

d. If the service fails to start, right click on the service, and select Properties from the content menu. 

e. Select the Log On tab. Re-enter the service account password in the provided fields and click OK. 

f. Attempt to start the service again by right clicking on the service, and selecting Start from the context 

menu. If the service again fails to start, verify that the service account is operating correctly and is not 

locked out. 

Failure to perform this step will cause the install to fail with a 1920 error if there is a problem with the service 

account or its password. This can be corrected by following the same steps while the 1920 error is displayed. 

Do not cancel the 1920 error dialog box because it will fail to upgrade and your system will have to be 

restored from backups. When you have corrected the service account password, click Retry in the 1920 error 

dialog box. 

7. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Locate the temporary folder where you extracted the files in a previous step. Start the upgrade by double 

clicking on CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). 

b. From the ADTRAN NetVanta Unified Communications CD Menu (opened when the CD was inserted in a 

previous step), click the Install Server button to prepare the NetVanta UC Server upgrade. 

8. On an upgrade from previous releases, you could be required to install or update prerequisite components. 

Click on the Verify or automatically install remaining components button to proceed. Some components 

might require downloading from the vendor’s websites. 

9. Adding the NetVanta UC Server Presence and Control Components: 

a. If you are using the NetVanta Unified Communications Server product variant, or if you do not plan on 

using NetVanta ucCompanion - Live Attendant: 
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 Disable the following option: Install Presence Components. 

 Click Next. 

b. If you plan on upgrading the Presence and Control Components from a 4.2.x, 4.3.x, 4.4.x, 4.5.x, 4.6.x or 

5.0.x version you must first uninstall the existing version via Add/Remove control panel applet: 

 Navigate to the install media and locate the ADTRAN NetVanta ucCompanion.msi and launch the 

installer and follow the dialog box. 

 Click Install on the ADTRAN NetVanta UC Live Attendant Server Components Setup Wizard 

screen. 

 Click Next on the welcome page of the ADTRAN NetVanta UC Live Attendant Server 

Components Setup Wizard and follow the prompts on subsequent screens until finished. Consult 

the NetVanta Unified Communications Server Presence and Control Components Guide for additional 

installation documentation. 

 Click Finish when complete. 

 Click Yes when prompted to restart the system for the configuration changes to take effect. 

10. Upgrading the NetVanta UC Server.  

a. If upgrading from 4.2.x, 4.3.x, 4.4.x, 4.5.x, 4.6.x, or 5.0.x: 

 The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear briefly 

as the upgrade does various checks on the system. 

 Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified 

Communications Server Setup Wizard appears and follow the prompts to complete the upgrade. 

 Click the Finish button to close the setup wizard and return to the Preparing NetVanta UC Server 

Installation dialog box. 

b. If upgrading from 4.0.x or 4.1.x Trial: 

 Install the server application to the NetVanta UC Server platform by clicking on the Install UC 

Server button.  

 The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear briefly 

as the upgrade does various system checks.  

 Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified 

Communications Server Setup Wizard appears. 

 Continue clicking the prompts to complete the upgrade. 

 Click the Finish button to return to the Preparing UC Server Installation dialog box.  

11. Click the Configure UC Server button to launch the NetVanta UC Server Configuration Wizard. 

NOTE:  If all the steps in the server configuration were completed prior to the upgrade, you will be presented with 

three options (Change Service Account, Users, and Phone Types).  You could be required to perform the first 

option, Change Service Account to reset the service account to what was configured prior to the upgrade. 

12. In an upgrade from 4.0.x you need to complete Gateway configuration in the NetVanta UC Server 

Configuration Wizard then reset the service account: 

a. Click on the Configure UC Server to launch the NetVanta UC Server Configuration Wizard. 

b. When prompted to login, login as a user with NetVanta UC Server administrative privileges. 

c. Complete the Gateways portion of the wizard. (Select Next, select None, then Next, then click Finish to 

close the Gateway wizard). 

d. Click Exit to close the NetVanta UC Server Configuration Wizard. 

e. Click the Configure UC Server button in the Preparing UC Server Installation dialog box. 

f. Login as a user with NetVanta UC Server administrative privileges when prompted. 

g. Click on the Change Service Account option and proceed to configure the service account.  

h. Select the service account that was configured prior to the upgrade. 

i. Click Close to exit the NetVanta UC Server Configuration Wizard. 

j. Click Close to exit the Preparing UC Server Installation. 
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13. For ECS and BAS product variants, run the Post-Update.bat script file as follows: 

a. Locate the command window opened in Step 0. 

b. Run the Post-Update.bat script, supplying any appropriate parameters relevant to your installation: 

Syntax: Post-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder] 

 If your UC Server installation is not located at C:\Program Files\ADTRAN\NetVanta UC 

Server\, you must specify the location of the PhoneTypes system data folder as shown 

below in the example. 

 If backups were written to a location other than C:\Backup\PhoneTypes, then you must 

specify the same backup folder as specified in Step 0. 

 The /? option provides help on the script; the /V option provides more detailed output and 

logging. 

Example: Post-Update.bat "C:\Program Files\ADTRAN\NetVanta UC 
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\" 

c. When the script prompts you to continue, confirm the information displayed, type Y, and then press 

Enter. 

d. Examine the output of the script to ensure it ran correctly. The output is placed in a file called 

Post-Log.txt in the backup location, which defaults to C:\Backup\PhoneTypes. 

 

e. When the script completes, it will indicate if any site-specific customizations have been made. Details of 

the customizations will be output to a file called FileComparison.txt in the backup location. The 

default backup location is C:\Backup\PhoneTypes. 
 

f. The Post-Update script will only update all of the “attributes.xml” files for each phone type in use. It will 

not modify any other files automatically. Please re-apply any necessary custom configuration to all other 

files listed in “FileComparison.txt”. For any questions or concerns, please refer to phone vendor 

documentation or contact ADTRAN support for guidance. Once any customizations have been re-

applied, restart the ADTRAN NetVanta UC Server Application Services service using the Services 

administrative tool. 

 

IMPORTANT  NOTICE:   For upgrades of  ADTRAN phone family types, custom configurations 
will be lost unless the following changes are made prior to running the Pre-Update.bat 

 Locate the ADTRAN.original.zip on the release media  

 Extract to the following location:  "C:\Program Files\ADTRAN\NetVanta UC 
Server\Data\System\PhoneTypes\ADTRAN 

 Run the Pre-update and Post-update instructions as noted below  
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IMPORTANT  NOTICE:   Since some phone firmware required for supporting new features in this 
release have changed, the following phone family types including Polycom and snom’s existing 
user customized configuration files  (.cfg)  will be overwritten during an upgrade and cannot be 
merged as a result of the post-update script execution as noted above.  Custom configuration will 
require user to edit  the new .cfg files after the upgrade and associated phone firmware revision 
update. 

 

14. Update the RestartOverrides.cfg file (located in …\NetVanta UC Server\Data\System\Recovery\) 

according to the following conditions: 

a. If manual changes have been made to this file, then you must manually copy any entries from 

RestartOverrides.cfg.original to RestartOverrides.cfg that are not present in the latter file. 

b. If no manual changes were made to this file, then replace the contents of RestartOverrides.cfg with 

the contents of RestartOverrides.cfg.original.  It is not necessary to restart the ADTRAN 

NetVanta UC Server Application Services service. However, if the file has been appended to instead of 

being replaced, then the application service must be restarted for the changes to take effect. 

15. If Install Presence Components was selected in Step 9, you will be required to configure these components 

at this time. Please consult the NetVanta Unified Communications Server Presence and Control Components 

Guide for configuration documentation. If this is an upgrade from 4.2.x, 4.3.x, 4.4.x, 4.5.x 4.6.x or 5.0.x, then 

the NetVanta UC Server Presence and Control Components could have already been configured. 

16. For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please 

refer to Section 3.7, Configuring Services, of the Installation Guide. 

17. For ECS and BAS product variants, re-apply phone configurations to all phones in the system as follows: 

a. Open NetVanta UC Client and log in as a user with administrative privileges. 

b. Click on the Administration navigation bar. 

c. Click on the Phones folder in the Administration navigation bar. 

d. In the contents pane, select all phones by clicking on the first phone, then pressing Shift-Ctrl-End on the 

keyboard. All phones should now be selected. 

e. Right click on one of the selected phones, and select Reload Configuration from the menu. This will 

cause all phone configuration files to be regenerated and phones to reload their configuration data 

(rebooting most phone types). 

4.2.3 Cross-grading from CallAttendant Office Server 4.0.x/4.2.x to NetVanta UC Server 

CAUTION:  The existing version of CallAttendant Office must NOT be uninstalled prior to cross-
grading. The installation process requires that the existing implementation be available in order to 
perform the upgrade correctly. 

The following is a summary of the procedure for cross-grading your CallAttendant Office release 4.0.x/4.2.x 

software, please consult the Installation Guide for detailed instructions on installing the NetVanta UC Server 

component.  If the CallAttendant Office software is currently below the 4.0 Software versions, you must first 

upgrade to Release 4.0.x version.  

This upgrade will take significantly longer as the NetVanta UC Server installation program will make a complete 

copy of the data for the upgraded installation. For large installations where voice and fax messages are stored on 

locally, it can take one to two hours to copy the data during the upgrade. Do not cancel the upgrade during this 

process. As a result, this upgrade will require at least twice as much disk space as the Data folder occupies in order 

to perform the upgrade. 
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Prior to upgrading to release 4.0.x, do the following: 
1. Backup the CallAttendant Office using the instructions found in TN071 – Backup and Restore Procedures for 

CallAttendant Office, available online at https://supportforums.adtran.com, to preserve the following data: 

 

a. Users (greetings, services, announcements) 

b. Port configuration 

c. Attendant data 

d. System configuration 

e. Routing data 

f. Telephone data 

g. Gateway data 

CAUTION:  Failure to backup the data according to these instructions and the Technical Note will 
result in the inability to restore the system to the original configuration should the upgrade process 
be unsuccessful or aborted. Always back the system up prior to upgrading. 

2. Record the CallAttendant Office service account username and password. This can be done using the Services 

Control Panel application. Select the CallAttendant Office service and record the username. The password 

must already be known because it cannot be viewed in the Services Control Panel. 

3. You must have an up-to-date license key to support the latest release of CallAttendant Office 4.0.x and 

NetVanta UC Server (in some circumstances, you could receive two license keys that will be used to support 

the upgrade). To obtain a new license key, please refer Section 3.3.3, Obtaining a New License Key. 

4. Ensure that you enter the new license key in the CallAttendant Office administrator application (Help > 

License Information) menu prior to upgrading the software. 

CAUTION:  If an existing PBX is being replaced with NetVanta Enterprise Communications Server, 
please contact support@adtran.com for additional instructions. 

To install NetVanta UC Server: 

1. Rename all of the configuration files in the .\Data\System by appending .old to the existing filename: 

Example: C:\Program Files\Objectworld\CallAttendant Office 

Server\Data\System\DefinityPBXDefinition.cfg to DefinityPBXDefinition.cfg.old 

2. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will 

need to provide a location and name for the folder).  Start the installation by double clicking on 

CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a 

copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade 

Media. 

b. Insert the NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta 

Unified Communications CD menu will appear. 

3. If you plan on using NetVanta ucCompanion – Live Attendant, install or update the NetVanta UC Server 

Presence and Control components at this time. Consult the NetVanta UC Server Presence and Control 

Components Guide for installation documentation, which is provided on the distribution media. 

4. Install the server applications to the NetVanta UC Server platform by clicking on the Install UC Server 

buttons on the NetVanta UC Server installation screen and following the prompts on the subsequent screens 

until finished. 

5. For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please 

refer to Section 3.7, Configuring Services, of the Installation Guide. 

6. Once the installation has completed, select the Configure UC Server button to run the Server Configuration 

Wizard, but do not add anything if it has already been configured. From the set of options, at a minimum, 

complete the following tasks: 

mailto:support@adtran.com
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a. Enter the NetVanta UC Server license key to enable SIP functionality. 

b. Configure the Windows Network Integration and select from one of the following: 

i. If the service account was previously configured for Local System account, you must create a 

Windows account on the local machine.  Operating the Application Services service on the Local 

System account is no longer supported. 

ii. If the service account was previously configured with a Windows Active Directory™ account, then 

configure the Existing Service Account. 

7. Open the Windows Services application and ensure that the ADTRAN NetVanta UC Server Application 

Services service is set to start automatically. Note, you might have to refresh (F5) the services application in 

order to get a current view of the status. From the Windows Services Applications, start the ADTRAN 

NetVanta UC Server Application Services service if it is not already started. 

8. Complete the remaining steps in the NetVanta UC Server Configuration Wizard. If appropriate, make any 

additional configuration changes required, such as adding NetVanta Enterprise Communications Server as a 

new communication system, adding new phone types or new gateways. 

4.2.4 Cross-grading from CallAttendant Office Server 3.2.x to NetVanta UC Server (all editions) 

NOTE:  It is not possible to upgrade directly from 3.x to 4.2 and later releases (Refer to Section 4.2.1, Upgrade/Cross-

grade Matrix). An upgrade from CallAttendant Office 3.x to CallAttendant Office 4.0.x must be performed as an 

intermediate step. Once this is complete, you can upgrade to the latest NetVanta UC Server 4.x release. 

To upgrade 3.x to 4.0.x: 

1. Backup the CallAttendant Office using the instructions found in TN071 – Backup and Restore Procedures for 

CallAttendant Office, available online at https://supportforums.adtran.com, to preserve the following data: 

a. Users (greetings, services, announcements) 

b. Port configuration 

c. Attendant data 

d. System configuration 

e. Routing data 

f. Telephone data 

g. Gateway data 

CAUTION:  Failure to backup the data according to these instructions and the Technical Note will 
result in the inability to restore the system to the original configuration should the upgrade process 
be unsuccessful or aborted. Always back the system up prior to upgrading. 

2. Stop the CallAttendant Office Service from the Windows Services application. 

3. Rename the following files: 

a. C:\Program Files\Objectworld\CallAttendant Office 

Server\Data\System\Announcements folder to Announcements.old 

b. C:\Program Files\Objectworld\CallAttendant Office 

Server\Data\System\DefinityPBXDefinition.cfg to DefinityPBXDefinition.cfg.old 

4. If the CallAttendant Office software was downloaded from the ADTRAN website, follow Step a. If the 

CallAttendant Office CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the CallAttendant Office server 

(you can create a CallAttendant Office folder). Start the installation by double clicking on 

CAAutoRun.exe (the CallAttendant Office installation screen will appear). Preserve a copy of the 

installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade Media. 

b. Insert the CallAttendant Office CD-ROM. The Auto run application will start and the CallAttendant Office 

installation screen will appear. 

5. Install the Server applications to the CallAttendant Office platform by clicking on the Install CallAttendant 

Office Server button on the CallAttendant Office installation screen and following the prompts on the 

subsequent screens until finished. Do not choose to reboot the computer at this point. 
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6. Open the Windows Services application and set the CallAttendant Office Service to start automatically. 

NOTE:  You might have to refresh (F5) the Services application in order to get a current view of the status. 

7. From the Windows Services applications, start the CallAttendant Office service. 

8. Convert the system audio.  If the software was upgraded from Release 3.1 or earlier, you must convert the 

audio from the pre-existing 11 kHz-8bit audio format to the newly supported 8 kHz mu-law audio. Although 

the CallAttendant Office server will change the audio format on-the-fly the conversion will introduce latency 

in playing audio files or messages. 

CAUTION:  Ensure that you perform the audio conversion during the maintenance window – 
typically, after normal business hours. 

To perform the audio conversion: 

1. From My Computer, navigate to the C:\Program Files\Objectworld\CallAttendant Office 

Server\Bin directory. 

2. Double-click on the ConvertAudio.exe application. 

4.2.5 Upgrading Client Software 

If anything other than a minor server upgrade has taken place, client software must be updated on end user 

computers; only 5.1.x client software is supported with 5.1.x server software. Refer to Section 4.3, Installing or 

Upgrading NetVanta UC Client Software, for installation options and procedures. 

4.3 Installing or Upgrading NetVanta UC Client Software 

This section documents manual installation procedures, and presents other techniques for automated client 

deployment. 

CAUTION:  Only release 5.1.x NetVanta UC Client software is compatible with NetVanta UC Server 
5.1.x software (the patch revision value ‘x’ does not need to be identical). All incompatible clients 
must be upgraded after the NetVanta UC Server has been upgraded. 

4.3.1 Manual Installation or Upgrade Instructions 

NOTE:  The user installing NetVanta UC Client software MUST have administrative privileges on that desktop 

computer. 

1. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the desktop computer (you will 

need to provide a location and name for the folder). Start the installation by double clicking on 

CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a 

copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade 

Media. 

b. Insert the NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta 

Unified Communications CD menu will appear. 

2. Install the client applications to the client computer by clicking on the Install Client button on the installation 

screen and following the prompts on the subsequent screens. 
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CAUTION:  Installing NetVanta UC Client directly on the NetVanta UC Server platform is not 
supported. Ensure that the client is installed on a separate platform meeting the minimum 
requirements. 

4.3.2 Other Techniques for Installing and Upgrading Client Software 

Client software can be deployed using automated techniques including: 

 GPO-based MSI installation. Refer to TN116 - Installing NetVanta UC Client Using GPO, available online at 

https://supportforums.adtran.com, for more information on this option. 

 GPO-based login scripts that invoke either SETUP.EXE or MSIEXEC.EXE with appropriate parameters. 

Prerequisite components must have been previously installed successfully. Consult standard Microsoft 

documentation for more information on those techniques. 

5 Support, Documentation, and Training 

5.1 Support 

Self-service support material can be obtained from the ADTRAN website, http://www.adtran.com/support, and 

from the ADTRAN Technical Support Knowledge Base, https://supportforums.adtran.com. 

Information on product support services can be obtained from the ADTRAN website: 

http://www.adtran.com/support. 

5.2 Documentation 

Product documentation and additional technical support material can be found on the ADTRAN website, 

http://www.adtran.com/support, and in the ADTRAN Technical Support Knowledge Base, 

https://supportforums.adtran.com. 

5.3 Training 

Information on current training programs and certifications can be found on the ADTRAN website: 

http://www.adtran.com/training. 

5.4 Product Downloads and Third-Party Drivers 

Product downloads and third-party drivers and patches are available in the support area of the ADTRAN website: 

http://www.adtran.com/support. 

  

http://www.adtran.com/support/
https://supportforums.adtran.com/
http://www.adtran.com/support/
http://www.adtran.com/support/
https://supportforums.adtran.com/
http://www.adtran.com/training/
http://www.adtran.com/support/
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6 Third-Party Interoperability 

CAUTION:  Some third-party drivers and applications may not support Windows Server 2008 and 
derived platforms (SBS 2008, 2010). When using TAPI integrations, or other integrations requiring 
the use of CTI drivers, please review driver documentation for those products BEFORE proceeding 
with plans to use Windows Server 2008 as the server platform for those deployments. 

Please consult information provided in TN051 – UC Server Interoperable SIP Devices and Services, available online 

at https://supportforums.adtran.com, for interoperability information related to: 

 SIP telephone terminals 

 SIP soft phones 

 SIP paging speakers, amplifiers and related devices 

 SIP wireless terminals 

 SIP gateways and application layer gateways (ALGs) 

 ITSPs 

Information on PBX integration and software applications is provided below in this document. 

6.1 NetVanta UC Server with a PBX Integration 

6.1.1 Supported Private Branch Exchanges (PBX) 

NetVanta Unified Communications Server has the capability to connect to multiple traditional PBXs and IP PBXs 

while simultaneously supporting SIP services ECS.  NetVanta UC Server can be deployed as a voicemail, unified 

message server, database IVR platform, and fax server behind a traditional PBX while also simultaneously 

supporting SIP telephony ECS.  This provides a useful transition strategy for companies looking to migrate to 

VoIP but who still want to leverage their existing infrastructure.  NetVanta UC Server users who employ a 

traditional PBX for telephony can still take advantage of Active Directory™ integration for user management; the 

telephony features will be managed through their PBX configuration interface. 

NetVanta UC Server integrates with a wide variety of traditional PBX and IP PBXs using Dialogic 1000 and 2000 

Media Gateways. The following PBXs are now supported using the Dialogic Media Gateway: 

 Alcatel Omni PCX 4400 

 Avaya Communications Manager 

 Avaya Definity G3 

 Avaya Legend 

 Avaya Merlin Magix 

 Avaya Partner 

 Ericsson BusinessPhone 

 Ericsson MD110 

 Intecom PointSpan M6880 

 Mitel 3300 

 Mitel SX-2000 

 Mitel SX-200D Family 

 NEC NEAX2400 

 Nortel CS-1000 

 Nortel DMS 10 

 Nortel DMS 100 

 Nortel Meridian 1 

 Phillips Sopho 

 Rolm (Siemens) 8000 

 Rolm (Siemens) 9000 

 Rolm (Siemens) 9751 

 Siemens HiCom 150E 

 Siemens HiCom 300 

 Siemens HiPath 4000 

 Toshiba CTX 

For more specific details on which PBX editions and interfaces are supported, consult the Dialogic Media Gateway 

documentation available from Dialogic’s website: http://www.dialogic.com/support/helpweb/mg/integration.htm. 

https://supportforums.adtran.com/
http://www.dialogic.com/support/helpweb/mg/integration.htm
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NetVanta UC Server also integrates with the PBXs listed in the table below using one of the following techniques: 

 Analog port integration with in-band tones using Dialogic® D/4PCIUF and D/120JST-LS Media Boards 

 Digital set emulation using Dialogic® D/82JCT-U and D/42JCT-U PBX Integration Boards 

 CTI link/analog port integration using Dialogic® D/4PCIUF and D/120JST-LS Media Boards 

 PBX Vendor supplied Microsoft TAPI/WAVE Service Providers 

PBX 

Vendor/Model 

Minimum 

Software 

Release 

Technical Note 

(TN) Reference 

Number 

Integration Type Third-Party 

Hardware/Software 

(Recommended) 

Avaya 

Communications 

Manager 

1.0 and above TN016 Digital set emulation: 

- 7434D emulation 

- 8434D emulation 

- 7434ND emulation 

Dialogic 6.0 SU 266 

Avaya Definity  

(no CLID) 

6.3 and above TN009 Analog port using 

mode codes; mode 

code option is required 

Dialogic 6.0 SU 266 

Avaya 

Definity/Multi-

Vantage 

(with CLID) 

4.0 and above TN010 

 

Digital set emulation: 

- 7434D emulation 

- 8434D emulation 

- 7434ND (7.5 and 

above) 

Dialogic 6.0 SU 266 

Avaya IP Office 2.0 and above TN012 CTI link/analog port 

using TAPI 

- IP 400 CTI link  

- IP 400 TAPI-WAVE 

Dialogic 6.0 SU 229 

Avaya Merlin 

Legend 

3.1 and above  Analog port using 

mode codes 

Dialogic 6.0 SU 229 

Avaya Merlin 

Magix  

(with CLID) 

2.1 and above TN008 Analog port using 

mode codes 

Magix CTI link bundle 

Dialogic 6.0 SU 229 

Avaya Merlin 

Magix 

(no CLID) 

2.1 and above TN008 CTI link/analog port 

using mode codes 

/TSAPI 

Dialogic 6.0 SU 229 

Avaya Partner ACS 3.0 and above  Analog port using 

mode codes 

Dialogic 6.0 SU 229 

Cisco Call Manager 4.2 TN039 Cisco-supplied 

Microsoft TAPI/WAVE 

Service Provider 

 

Mitel SX200 

(family) 

G1005/LW16 

F41.0.2 

TN011 Analog port using 

enhanced in-band 

DTMF tones 

Dialogic 6.0 SU 229 
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PBX 

Vendor/Model 

Minimum 

Software 

Release 

Technical Note 

(TN) Reference 

Number 

Integration Type Third-Party 

Hardware/Software 

(Recommended) 

Mitel 3300 (IVR 

only) 

Any version that 

requires ONS 

voicemail support 

 Analog port using  

in-band DTMF tones 

Dialogic 6.0 SU 229 

Nortel Norstar 4.2 and above TN003 Digital set emulation: 

- M7324 set emulation 

Dialogic 5.1.1 with 

PTR.31016 ** 

Generic in-band PBX dependent  Analog port using  

in-band DTMF tones 

Dialogic 6.0 SU 229 

** NetVanta UC Server ONLY supports Dialogic Release 5.1.1 software with PTR.31016 (LIBFAXMT.DLL) for 

Norstar PBXs since the Do Not Disturb feature does not work with Dialogic Release 6.0 for Nortel Norstar PBX. 

6.1.2 New Installation of Dialogic Software 

To install Dialogic software on the new NetVanta UC Server: 

1. Install the Dialogic System Software compatible with the PBX make and model. 

a. Run SETUP.EXE from Windows Explorer. 

i. When prompted to select features, select Core Runtime Package, select Next. 

ii. When advised that the installation will install third-party software, select Yes. The installation will 

detect and remove any existing Dialogic system software. 

iii. The first stage of the installation will require a reboot. When prompted to restart the system, 

select Yes. 

2. Verify through the Windows Hardware Device Manager that all of the Dialogic cards reside in the Dialogic 

Springware Devices section. 

NOTE:  If any of your cards appear to be improperly configured (for example, caution symbol or otherwise) then 

you will have to update the driver. 

a. To update the driver: 

i. Locate and configure the Dialogic card from Device Manager. 

ii. Select the Driver tab and select Update Driver. 

iii. Choose Search for suitable driver for my device (recommended), and click Next. 

iv. When the driver update locates the Dialogic Card, click Next. 

b. Repeat Step i through Step iv for each Dialogic card that appears improperly installed or configured. 

3. Run Dialogic Configuration Manager (Start > Programs > Dialogic System Release > Configuration Manager 

– DCM. DCM will detect any Dialogic hardware installed on the machine hosting NetVanta UC Server 

software. 

a. Ensure that the board settings match your PBX type. (The default configuration is Nortel Norstar.) 

b. For digital set emulation, open each card and ensure the MISC tab > PBXSwitch parameter is configured 

according to your integration. 

c. Refer to the relevant configuration guide 

4. Configure the Dialogic service to start automatically; Select Settings > System Device Autostart to Start 

System.  It is normal to encounter the error message Failed to set the Device Autostart setting. Requested 

data not found in NCM data storage. 

5. Proceed with NetVanta UC Server installation instructions. 
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6. Verify the Dialogic board ordering by running NetVanta UC Client as an administrator and call each port. If 

the ports are not answering in the correct order, switch the Dialogic cables on the back of the machine 

hosting NetVanta UC Server software. 

6.1.3 To upgrade Dialogic software on existing NetVanta UC Server (if required) 

Once you have determined that the Dialogic software version needs to be upgraded then perform the following 

steps: 

1. Remove existing Dialogic system software. 

a. Stop the existing NetVanta UC Server and Dialogic services. 

b. Launch the Microsoft Windows Service control application (Start > Settings > Control Panel > 

Administrative Tools > Services). 

i. Stop the service labeled ADTRAN NetVanta UC Server Application Services and change the 

service Startup type from Automatic to Manual. 

ii. Stop the service labeled Dialogic System Service. 

c. Remove the Dialogic System Software. 

i. Locate the Add/Remove Programs from the Windows Control Panel (Start > Settings > Control Panel 

> Add/Remove Programs). 

ii. Select and Remove the Dialogic software. 

d. Reboot the system as indicated. 

2. In rare instances, you might need to run a Dialogic utility to clean up the old Dialogic Release 5.1.1 installation 

files, directories, and registry settings. This batch file can be located in \cleanup\dlgc_rel_clean.bat in 

the Dialogic installation directory. This will be apparent if the Dialogic DCM – configuration management 

application is not installed. 

3. Install the Dialogic System Software. 

a. Follow the procedure in the previous section (New Installation of Dialogic Software) to install the required 

version of Dialogic applicable to your PBX. 

4. Launch the Microsoft Windows Service control application (Start > Settings > Control Panel > Administrative 

Tools > Services). 

a. Set the Startup type to Automatic for the service labeled ADTRAN NetVanta UC Server Application 

Services. 

6.2 Software Product Interoperability 

The following other software products have been tested and are known to work with NetVanta UC Server: 

Vendor Interoperability  

Level 

Product/Service Software Version 

Research In Motion 

(RIM) 

Interoperable BlackBerry Enterprise Server 

for Microsoft Exchange 

4.1 or newer 

BlackBerry Handheld Devices 4.2.1 rev 163, 4.2.2 or newer 

PhoneTag Interoperable PhoneTag 

(formerly SimulScribe) 

n/a 

Google Interoperable Google Mail (Gmail)  

using stunnel (SSL proxy) 

n/a 

stunnel 4.24 
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7 Known Software Limitations 

The following limitations are known in this NetVanta UC Server release: 

Tracking # ISSUE Workaround 

UCS-109 ucCompanion settings are not being retained on 

Upgrade from release 4.6.3  (known issue - 

unsupported) 

None 

UCS-140  Must uninstall existing server Presence and Control 

Components prior to running the 5.0.x as upgrade 

procedure 

Run the following switch with .msi file: 

REINSTALL=ALL REINSTALLMODE=vomus 

UCS-252 The ucCompanion DesktopClient will no longer be 

pinned to the start menu after an upgrade. 

None- Windows issue 

UCS-370 Self-healing not supported - UC forms preview 

pane registry setting 

You must install the client under the logged 

in account. 

UCS-343 ucCompanion may crash following "Run As" dialog 

prompt  

Do not “Run as” Administrator – change UAC 

settings or “Run as” default accordingly. 

UCS-271 By default, the server only accepts connections 

from the same version of client on the 5.x release 

Refer to the installation guide for more 

details. 

UCS-197 ucCompanion client will not be able to connect to 

the server from an untrusted client workstation by 

default 

Refer to the installation guide for more 

details. 

UCS-665   In a Refresh INVITE, UC receives a 200 with SDP 

but responds to the 7100 with an ACK without SDP. 

The call drops. 

Modify the SQL "useragentconfig" table 

entry for id "B2BUA" to increase the refresh 

timer 

UCS-664  Time improvements needed for setting up UC 

Trust relationship 

Wait up to 5 minutes to invite or receive  the 

Accept 

UCS-612  Federated trusted servers remains in disconnected 

state after network is unavailable for extended 

period  

Wait up to 5 minutes to invite or receive  the 

Accept 

UCS-656  NetVanta UC Management Shell launches with 

script execution error  

Set Get-ExecutionPolicy to the appropriate 

policy settings  via PowerShell 

 

UCS-655  PBA user that has shared admin service action 

cannot execute take message operation 

None 

UCS-644  Disconnecting from a conference call (after 

conferencing in a call recording service) fails to 

update presence 

Call the Recording service first, and then call 

the conference bridge. 

 

UCS-591  The administrator cannot update the Exchange 

server location  

Change manually when the mailbox is 

disconnected 
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Tracking # ISSUE Workaround 

UCS-399  Unanswered queue call from UC  (where queue 

provides ringback only) unexpectedly continues 

ringing caller 

Create a virtual user that forwards the 

incoming call to the queue extension and 

covers to an overflow extension 

UCS-585  ECS Server losing its network binding occasionally 

when running on VMWare virtual platform  

Ensure only one network adaptor is 

configured in VM for ECS  

UCS-542  MOH stops playing after call held for 15 minutes  None – as designed 

UCS-404 Service editor does not allow invalid service 
imports - auto corrections may leave orphaned 
elements. When executing these services, only the 
first element will get executed.  

Correct the service through the editor 

UCS-615 ucCompanion font issues with WPF generates 
exception 

Known Microsoft issue with WPF may require 

font re-installation or registry correction 

 

For more information on other “Known software limitations” please refer to the associated release notes for 

the specific release (e.g. 4.6.x or 5.0.x releases) 

 

 


